
Сборка Деталей
Вы можете формировать модели сборочных узлов из двух или более деталей или
деталей, сгруппированных в подсборки. Подобно элементам детали, детали и подсборки
действуют как компоновочные блоки. Mechanical Desktop собирает отдельные детали и
подсборки в сборочный узел.

В настоящем учебном пособии, Вы создадите сборочную модель плоскогубцев из
четырех деталей. Три из деталей находятся в файлах, которые вставлены как внешние
ссылки в файл сборки.

При использовании внешних ссылок деталей организуется параметрическая сборочная
конструкция. Изменения в внешней ссылке могут быть проведены как внутри самой
сборки, так и в оригинальном файле.

Ключевые термины

Термин Определение
3D constraint

(трехмерная зависимость)

В моделировании сборки, ассоциативная связь между двумя или
более деталями, которая управляет их положением относительно
друг друга и их размещением в пределах сборки.

Assembly Catalog

(каталог сборки)

Средства присоединения и упорядочивания локальных и внешних
деталей и подсборок в среде Моделирования Сборки. Используйте
ярлычки All и External для указания элементов, которые могут
ссылаться, копироваться, переименовываться, заменяться, входить
составной частью в другую сборку, удаляться, локализовываться,
сортироваться, выгружаться и перезагружаться.

assembly tree

(дерево сборки)

Графическая структура, иллюстрирующая порядок, в котором детали
и подсборки объединяются в текущую сборку. Дерево сборок
контролируется в Обозревателе.

attach

(присоединение)

Присоединение файла внешней ссылки к файлу текущей сборки.
Присоединение остается в текущем файле после сохранения файла.

Definition

(определение)

Вся информация, относящаяся к детали или узлу, включая его имя,
местоположение и атрибуты.

detach

(отсоединение)

Удаление файла внешней ссылки из сборки на постоянной основе.

external reference

(внешняя ссылка)

Деталь или сборка, которая входит в файл другой детали или сборки
на постоянной основе.

insert constraint

(наложение зависимости)

Совмещение центров и плоскостей двух кругов в указанном
направлении. Контролирует степени свободы сборки. Используется,
например, для связывания болта с отверстием.

localized part Изменение статуса детали от внешней к местной путем разрыва
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(локализация детали) связи с внешним файлом. Изменения, сделанные в локальной
детали относятся только к текущей детали или файлу сборки; на
файлы другой детали или сборки не воздействуют.

mate constraint

(зависимость соединения)

Совмещение плоскости или оси одной детали с плоскостью, точкой
или осью другой детали в указанном направлении. Исключает
возможность возвратно-поступательного движения.

rename definition

(переименование
определения)

В Детали или Каталоге Сборки, присоединенная внешняя деталь или
узел могут быть переименованы. Псевдоним отображается около
имени рисунка в круглых скобках.

Scene

(сцена)

Трехмерная ориентация сборки, которую Вы можете использовать
для создания двухмерного вида в режиме Drawing. Вы будете
использовать сцены для создания разнесенных или сборочных видов
без удаления зависимостей.

trail

(направляющая)

В разнесенном виде - линия, которая показывает порядок сборки
деталей.

tweak

(точная подстройка)

Корректировка положения деталей в сборочной сцене во избежание
перекрытия некоторых видов или для лучшего обзора некоторых
деталей.

Краткий Обзор Урока

Новые особенности в этом уроке

Новые элементы, включенные в эту обучающую программу

• Использование улучшенного Каталога Сборки

• Предварительный осмотр внешних деталей и сборок

• Редактирование внешних ссылок в самом сборочном чертеже

• Работа с листами рисунков

• Использование улучшенных инструментов просмотра рисунка

Дополнительную информацию по новым и улучшенным элементам, см. главу 3, «Новые
элементы» в руководстве «Начинаем работать».

Базовая Концепция Сборки Деталей

Вы создаете сборки из деталей индивидуальных или сгруппированных в подсборки.
Mechanical Desktop формирует такие отдельные детали и подсборки в иерархическую
сборку в соответствии с наложенными зависимостями.

Как и при моделировании деталей, параметрические зависимости позволяют Вам быстро
модифицировать всю сборку при изменении одной из ее деталей.

Вы можете собирать трехмерные твердотельные сборки из двух или более деталей или
подсборок. Подобно элементам детали, детали и подсборки работают как
компоновочные блоки.
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Следующий процесс формирования сборок и подсборок подобен формированию
деталей:

• Разместите сборку.

• Создайте основную деталь.

• Создайте оставшиеся детали.

• Создайте сборку и подсборки.

• Проанализируйте сборку.

• Измените сборку при необходимости.

Когда Вы создаете файл сборки, Вы можете создавать ваши детали в сборочном
чертеже или Вы можете ссылаться на внешние файлы.

Использование внешних ссылок дает Вам большую гибкость при управлении вашей
сборкой. Если Вы должны сделать изменение в любой из ваших деталей, Вы можете
открыть файл отдельной детали и сделать в ней изменения. Поскольку в одной сессии
Mechanical Desktop могут быть открыты более одного рисунка, Вы можете сразу увидеть
ваши изменения в файле сборки. Вы можете также редактировать внешние ссылки,
находясь в файле сборки. Это особенно полезно в небольших сборках. В зависимости от
ресурсов вашей системы, Вы можете редактировать внешние файлы отдельно, если они
принадлежат большой сборке.

После того, как Вы собрали ваши детали, Вы должны проверить сборку на соударение.
Вы можете также рассчитать масс-инерционные характеристики ваших деталей, чтобы
обеспечить их требуемую структуру.

Наконец, Вы должны создать документацию к вашему проекту. Для облегчения
визуализации вашей конструкции, Вы можете скорректировать или провести точную
подстройку вашей сборки и добавить направляющие, чтобы показать, как ваши детали
собираются. Затем, Вы создаете ваши чертежные виды и добавляете информацию, типа
справочных размеров и аннотаций, перед выводом рисунка на печать.

Начало Сборки Конструкции
Проект сборки может начинаться как полный концептуальный проект. Вы можете знать,
как собираются детали, но Вы можете не знать все подробности по каждой детали.

Прежде, чем Вы начнете - определите, как Вы хотите расположить вашу сборку.

• Начните с идеи проекта.

• Решите, должны ли Вы создавать новые детали или Вы будете использовать
существующие.

• Начните рисовать детали.

В этом уроке, Вы соберете детали в логическом порядке, начиная с верхнего уровня
дерева сборки. Одна деталь уже была создана в учебном файле для этого урока. Другие
три детали находятся в разных файлах. Вы присоедините файлы и затем сделаете их
внешней ссылкой.

Откройте файл s_plier.dwg в папке desktop\tutorial.

ОБРАТИТЕ ВНИМАНИЕ Сделайте резервную копию файлов учебных чертежей, чтобы
Вы имели оригинальные файлы на случай ошибки. См. «Резервное Копирование Файлов
Учебных Чертежей» на странице 7.
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Разверните Обозреватель. Деталь PLIERB вложена в пиктограмму сборки.

Затем, Вы вставите внешнюю ссылку на три других детали, чтобы создать сборку.

Использование Внешних Ссылок в Сборке
Детали, которые составляют сборочную модель, могут быть созданы и обрабатываться в
других файлах. Эти детали называются внешними ссылками. При изменении детали, все
ее вхождения в других файлах автоматически обновляются.

Использование деталей из других файлов подобно внешним ссылкам (xref) в AutoCAD.
Поскольку они внешние, Вы можете многократно использовать упомянутые детали в
будущих сборках. Вы можете создавать библиотеки часто используемых деталей в
каталоге, где они могут быть легко размещены. Внешние ссылки могут входить в текущий
файл в любое время.

Для присоединения внешней ссылки
1. Чтобы начать присоединять внешние детали, выберите один из следующих методов:

Обозреватель Щелкните по кнопке Catalog.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Catalog.

Пиктограмма Assembly Catalog

Меню Desktop Assembly → Catalog

Команда AMCATALOG

2. В Каталоге Сборки выберите ярлычок External (Внешний) и включите Return to Dialog
(Вернуться в Диалоговое Окно).

3. В окне Directories (Каталоги) щелкните правой кнопкой мыши и выберите Add Directory
(Добавить Каталог).
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4. Укажите папку desktop\tutorial и нажмите ОК, чтобы сделать ее вашим рабочим каталогом.

ОБРАТИТЕ ВНИМАНИЕ Если установили Mechanical Desktop в другой каталог -
выберите соответствующую папку.

Все файлы чертежей в папке desktop\tutorial перечислены под Part and Subassembly

Definitions (Определения Деталей и Подсборок) в ярлычке External (Внешний).

5. Подсветите определение PLIERT и дважды щелкните, чтобы вставить ссылку в рисунок.

Вы можете также щелкнуть правой кнопкой мыши по определению Catalog и выбрать
Attach (Присоединить).
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6. Ответьте на запросы следующим образом:
Specify new insertion point: Укажите точку под PLIERB

Specify insertion point for another instance or <continue>: нажмите ENTER

Файл pliert.dwg присоединен к текущей сборке и ссылка на него вставлена в текущую
сборку. В Каталоге Сборки PLIERT отображается на белом фоне.

Обратите внимание, что каждому из внешних файлов предшествует пиктограмма,
указывающая, является этот файл сборкой или деталью.

7. Присоедините ссылку на детали HEXNUT и HEXBOET к текущей сборке.

При выполнении ссылки на каждую деталь, Вы возвращаетесь в Каталог Сборки. В
списке Part and Subassembly Definitions (Определения Деталей и Подсборок), каждая
присоединенная деталь отображается на белом фоне. Когда все детали войдут в сборку
– нажмите OK.

Изучите Обозреватель. Четыре детали вложены согласно определению сборки.
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Каждая деталь имеет номер. Поскольку Вы создаете вхождения деталей, каждое
вхождение нумеруется, чтобы указать порядок, в котором Вы добавляли их к сборке.

Обратите внимание, что PLIERT, HEXBOLT и HEXNUT имеют подкрашенные
пиктограммы. Это указывает, что детали являются внешними ссылками.

8. Перейдите к изометрическому изображению вашего рисунка.

Пиктограмма Right Front Isometric View

Меню Desktop View → 3D Views → Front Right Isometric

Теперь Вы готовы начать процесс сборки.

Сборка Деталей
После создания деталей и подсборок, Вы накладываете зависимости для
позиционирования их относительно друг друга. Каждый раз, когда  Вы накладываете
зависимость на деталь, Вы лишаете ее некоторой степени свободы (DOF). Число
степеней свободы определяет подвижность детали в каком либо направлении; чем
больше зависимостей наложено, тем меньше деталь может двигаться.

Символ степеней свободы показывает порядок вхождения деталей и то, как они могут
двигаться. DOF символ показывает, скольких степеней свободы деталь лишена и
помогает Вам визуализировать и накладывать зависимости на детали.

Наложите несколько сборочных зависимостей на две детали, чтобы полностью
определить их положение относительно друг друга. Болт может поворачиваться (степень
подвижности при вращении не ограничена), но до тех пор, пока оси болта и отверстия не
совмещены, а поверхность болта не соприкасается с поверхностью отверстия, никакие
другие зависимости не требуются.

Поскольку детали и их сборочные зависимости параметрические, они могут быть
отредактированы. Сборочные зависимости, наложенные на каждую деталь постоянно,
сохраняются вместе со сборкой и позволяют параметрическое обновление изменении
детали.

Для отображения DOF символа
1. Используйте Обозреватель, чтобы отобразить DOF символ для HEXBOLT_1.

Обозреватель Щелкните правой кнопкой мыши по HEXBOLT_1 и выберите DOF
Symbol.
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DOF символ отображается в центре HEXBOLT. Это означает, что болт может
перемещаться в любом направлении.

Наложение Зависимостей На Детали

Используйте зависимость соединения для сопряжения деталей PLIERT и HEXBOLT.
Увеличьте изображение при необходимости.

Для добавления зависимости соединения между деталями
1. Создайте зависимость соединения.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите трехмерные Constraints → Mate.

Пиктограмма Mate

Меню Desktop Assembly → 3D Constraints → Mate

Команда AMMATE

2. Ответьте на запросы следующим образом:
Select first Set of geometry: Выберите HEXBOLT (1)

First Set = Axis, (arc)

Select first Set or [Clear/fAce/Point/cYcle] <accept>: Введите а для подсветки
поверхности
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First Set = Plane

Enter an option [Clear/aXis/Point/Flip/cYcle] <accept>:

Перебирайте y до подсветки следующей поверхности или нажмите ENTER

3. Выберите второй набор геометрии для наложения зависимости на соединение.
Select second Set of geometry: Выберите PLIERT (2)
Second Set = Axis, (arc)

Select second Set or [Clear/fAce/Point/cYcle] <accept>:

Введите а для подсветки соответствующей поверхности HEXBOLT
Second Set = Plane

Enter an option [Clear/aXis/Point/Next/Flip/cYcle] <accept>:

Перебирайте y до подсветки следующей поверхности или нажмите ENTER

Enter offset <0.0000>: нажмите ENTER

Для выбора геометрии, введите ответы в командной строке или используйте
анимированный указатель для перебора опций. Щелкайте левой (красной) кнопкой мыши
для перебора. Затем, нажмите правую (зеленую) кнопку мыши для подтверждения. Вы
можете также использовать анимированный указатель для выбора поверхностей,
указанием области, которую занимает поверхность, затем перебором выбрать другую
поверхность.

Соответствующие поверхностей деталей HEXBOLT и PLIERT – связаны друг с другом.

ОБРАТИТЕ ВНИМАНИЕ DOF символ полезен при наложении зависимостей, но для
ясности был выключен в иллюстрациях.

4. Используйте зависимость соединения при совмещении HEXBOLT с отверстием болта на
детали PLIERT по их оси.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите трехмерные Constraints → Mate.

Пиктограмма Mate

Меню Desktop Assembly → 3D Constraints → Mate

Команда AMMATE
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5. Ответьте на запросы следующим образом:
Select first Set of geometry: Укажите конец HEXBOLT (3)

First Set = Axis, (arc)

Select first Set or [Clear/fAce/Point/cYcle] <accept>: нажмите ENTER

Select second Set of geometry: Выберите отверстие под болт в PLIERT (4)

Second Set = Axis, (arc)

Select second Set or [Clear/fAce/Point/cYcle] <accept>: нажмите ENTER

Enter offset <0.0000>: нажмите ENTER

Дополнительно к зависимости соединения поверхностей головки болта и плоскогубцев,
HEXBOLT и отверстие под болт PLIERT связаны по оси.

6. Изучите DOF символ.

Видно, что осталась только степень свободы вращения. В нашем случае ее не требуется
ограничивать.

Вы можете использовать зависимость вставки для ограничения этих же степеней
свободы. При выборе поверхностей HEXBOLT и PLIERT, оси деталей совмещаются и
накладывается зависимость соединения на их соответствующие поверхности.

ОБРАТИТЕ ВНИМАНИЕ Для упрощения выбора деталей используйте команду MOVE
для перемещения ограничиваемой зависимостями детали. Деталь будет автоматически
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возвращаться в свое зависимое положение, как только Вы добавите новую сборочную
зависимость.

Соединения с основной деталью
1. Включите DOF символ для PLIERB.

Обозреватель Щелкните правой кнопкой мыши по PLIERB_1 и выберите DOF
Symbol.

DOF символ представлен номером в круге, указывающем, что он не имеет никаких
степеней свободы. Поскольку это – первая деталь, созданная в сборочном чертеже,
PLIERB становится основной деталью. По мере наложения сборочных зависимостей,
основная деталь остается постоянной. Если Вы перемещаете основную деталь, все
детали, привязанные к ней также перемещаются.

2. Соедините детали PLIERB и PLIERT.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 3D Constraints → Mate.

Пиктограмма Mate

Меню Desktop Assembly → 3D Constraints → Mate

Команда AMMATE

3. Ответьте на запросы следующим образом:
Select first Set of geometry: Выберите внутреннюю поверхность PLIERB (5)

First Set = Axis, (arc)

Select first Set or [Clear/fAce/Point/cYcle] <accept>: Введите а для подсветки
поверхности

First Set = Plane

Enter an option [Clear/aXis/Point/Flip/cYcle] <accept>:

Перебирайте y до подсветки следующей поверхности или нажмите ENTER

4. Выберите второй набор геометрии для наложения зависимости на соединение.
Select second Set of geometry: Выберите внутреннюю поверхность  PLIERT (6)

Second Set = Axis, (arc)

Select second Set or [Clear/fAce/Point/cYcle] <accept>:

Введите а для подсветки поверхности

Second Set = Plane

Enter an option [Clear/aXis/Point/Next/Flip/cYcle] <accept>:

Перебирайте y до подсветки внутренней поверхности или нажмите ENTER

Enter offset <0.0000>: нажмите ENTER
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Две губки плоскогубцев теперь соединены по соответствующей плоскости.

Для соединения деталей по их оси
1. Соедините деталь HEXBOLT с деталью PLIERB по их осям. Болт проходит через

отверстие в плоскогубцах.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 3D Constraints → Mate.

Пиктограмма Mate

Меню Desktop Assembly → 3D Constraints → Mate

Команда AMMATE

2. Ответьте на запросы следующим образом:
Select first Set of geometry: Выберите отверстие под болт в PLIERT (7)

First Set = Axis, (arc)

Select first Set or [Clear/fAce/Point/cYcle] <accept>: нажмите ENTER

Select second Set of geometry: Выберите отверстие под болт в PLIERB (8)

Second Set = Axis, (arc)

Select second Set or [Clear/fAce/Point/cYcle] <accept>: нажмите ENTER

Детали PLIERB и PLIERT соединены вдоль линии, проходящей через их отверстия, и
через них проходит болт.

3. Используйте зависимость соединения для наложения зависимости HEXNUT на
поверхности плоскогубцев.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 3D Constraints → Mate.

Пиктограмма Mate

Меню Desktop Assembly → 3D Constraints → Mate

Команда AMMATE

4. Ответьте на запросы следующим образом:
Select first Set of geometry: Выберите верхнюю поверхность HEXNUT (9)
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First Set = Axis, (arc)

Select first Set or [Clear/fAce/Point/cYcle] <accept>: Введите а для подсветки
поверхности

First Set = Plane

Enter an option [Clear/aXis/Point/Flip/cYcle] <accept>:

Перебирайте y до подсветки следующей поверхности или нажмите ENTER

5. Выберите второй набор геометрии для наложения зависимости соединения.
Select second Set of geometry: Выберите внешнюю поверхность  PLIERВ (10)

Second Set = Axis, (arc)

Select second Set or [Clear/fAce/Point/cYcle] <accept>:

Введите а для подсветки поверхности

Second Set = Plane

Enter an option [Clear/aXis/Point/Next/Flip/cYcle] <accept>:

Введите f для указания направления внутрь PLIERВ и, затем, нажмите ENTER

Enter offset <0.0000>: нажмите ENTER

Плоскость HEXNUT соединена с поверхностью PLIERB.

6. Соедините гайку с болтом по их осям так, чтобы болт прошел через отверстие.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 3D Constraints → Mate.

Пиктограмма Mate

Меню Desktop Assembly → 3D Constraints → Mate

Команда AMMATE

4. Ответьте на запросы следующим образом:
Select first Set of geometry: Выберите отверстие под болт в HEXNUT (11)

First Set = Axis, (arc)

Select first Set or [Clear/fAce/Point/cYcle] <accept>: нажмите ENTER

Select second Set of geometry: Выберите отверстие под болт в PLIERВ (12)

Second Set = Axis, (arc)
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Select second Set or [Clear/fAce/Point/cYcle] <accept>: нажмите ENTER

Enter offset <0.0000>: нажмите ENTER

Детали собраны.

8. Проверьте корректность сборки деталей.

Пиктограмма Top View

Меню Desktop View → 3D Views → Top

9. Вернитесь к изометрическому изображению.

Пиктограмма Right Front Isometric View

Меню Desktop View → 3D Views → Front Right Isometric

Сохраните ваш файл.

Использование Обозревателя

По мере сборки деталей, Вы можете просматривать каждую деталь и ее зависимости в
Обозревателе. Обозреватель не только отображает графическую иерархию сборки, но
также показывает какие зависимости наложены на каждую деталь.

Вы можете использовать Обозреватель для добавления, изменения, удаления и
копирования. Чтобы увидеть, как это работает, отредактируйте зависимость соединения
с болтом. Затем измените цвет детали и сделайте копии.

Для редактирования сборочных зависимостей  в Обозревателе
1. Разделите экран на два видовых экрана.

Пиктограмма Two Viewports

Меню Desktop View → Viewports → 2 Viewports

Команда MCAD2

2. Увеличьте болт.

Контекстное Меню В графической области щелкните правой кнопкой мыши и
выберите Zoom.

Пиктограмма Zoom

Меню Desktop View → Zoom → Realtime
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3. В Обозревателе щелкните правой кнопкой мыши по зависимости Mate pl/pl под
HEXBOLT_1, и выберите Edit.

4. В диалоговом окне Edit 3D Constraint измените отступ на 0.05. Щелкните по пиктограмме
Update.

Вы видите, что болт сместился на новое расстояние. Поэкспериментируйте с
изменением величины отступа, используя пиктограмму Update.

Выберите Cancel. Смещение оригинала составит 0.00.

Вы можете легко редактировать значения и видеть изменения без проведения изменений
в сборке на постоянной основе. Используйте пиктограмму Update в диалоговом окне Edit
3D Constraint, чтобы просмотреть изменения и, затем, выберите Cancel для возврата к
первоначальным значениям.

Для копирования детали в Обозревателе
1. Сверните дерево сборки для лучшей визуализации изменений, которые Вы собираетесь

провести.

Обозреватель Щелкните правой кнопкой мыши по S_PEIER и выберите Collapse.

2. Сделайте копию HEXBOLT_1.

Обозреватель Щелкните правой кнопкой мыши по HEXBOLT_1 и выберите Copy.

3. Разместите одну или более копий плоскогубцев и нажмите ENTER.

Вы увидите новые болты в структуре Обозревателя, пронумерованные в той
последовательности, в которой они были добавлены.
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Для изменения цвета детали в Обозревателе
1. Активизируйте HEXBOLT_1.

Обозреватель Щелкните правой кнопкой мыши по HEXBOLT_1 и выберите
Activate Part.

2. Измените цвет HEXBOLT_1.

Обозреватель  Щелкните правой кнопкой мыши по HEXBOLT_1 и выберите
Properties → Цвет.

3. В диалоговом окне Select Color (Выбрать Цвет) выберите Red (Красный) и нажмите ОК.

Этот цвет применится ко всем вхождениям HEXBOLT.

Затем, верните цвет болта в оригинальный и удалите экспериментальные копии.

4. Верните цвет HEXBOLT_1 к белому.

Обозреватель  Щелкните правой кнопкой мыши по HEXBOLT_1 и выберите
Properties → Color.

5. В диалоговом окне Select Color (Выбрать Цвет) выберите White (Белый) и нажмите ОК.

6. Активизируйте PLIERB_1.

Обозреватель  Щелкните правой кнопкой мыши по PLIERB_1 и выберите Activate
Part.

7. Удалите копию HEXBOLT.

Обозреватель  Щелкните правой кнопкой мыши по HEXBOLT_2 и выберите
Delete.

8. Повторите для всех копий, при необходимости.

Ваши экспериментальные копии и цвета больше не видны в структуре сборки
Обозревателя. Теперь Вы готовы выяснить масс-инерционные свойства и наличие
соударений сборки.

Получение Информации По Сборке
Теперь, когда на все детали наложены зависимости, Вы можете проверить наличие
соударений и получить масс-инерционные характеристики некоторых деталей или всей
сборки.

Проверка наличия соударения между двумя или более деталями в сборке может
означать конструктивные проблемы до начала производства. Масс-инерционные
характеристики позволят вам сделать вывод, требуется ли изменение размеров или
материала детали для достижения требуемых результатов. Такой анализ важен при
принятии решения на раннем этапе конструирования и может предотвратить
производственные проблемы в дальнейшем.
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Анализ Соударения

Анализ соударения обнаруживает соударение между двумя деталями или всеми
деталями. Вы можете перемещаться вверх или вниз по дереву сборки, выбирая
анализируемые детали. Затем, Вы выполняете анализ соударения для всей сборки.

Для проверки на соударение
1. Перейдите в один из видовых экранов

Пиктограмма Two Viewports

Меню Desktop View → Viewports → 1 Viewports

Команда MCAD1

2. Перейдите в правый изометрический вид.

Пиктограмма Right Front Isometric View

Меню Desktop View → 3D Views → Front Right Isometric

3. Проверьте на соударение.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Analysis → Check Interference.

Пиктограмма Check 3D Interference

Меню Desktop Assembly → Analysis → Interference

Команда AMINTERFERE

4. Ответьте на запросы следующим образом:
Nested part or Subassembly selection? [Yes/No] <No>: нажмите ENTER

Select first Set of parts or subassemblies: Выберите деталь PLIERT (1)

Select first Set of parts or subassemblies: нажмите ENTER

Select second Set of parts or subassemblies: Выберите деталь HEXBOLT (2)

Select second Set of parts or subassemblies: нажмите ENTER

Parts/subassemblies do not interfere.

Если у Вас возникают сложности при выборе детали, используйте Обозреватель для
изменения ее цвета.

5. Проверьте наличие соударения между деталями PLIERB и HEXBOLT. Детали не должны
иметь никакого соударения.

Затем, рассчитайте масс-инерционные характеристики сборки.
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Расчет Масс-Инерционных Характеристик

Как только сборка будет завершена, Вы можете вычислить ее масс-инерционные
характеристики. Значения допусков контролируют точность масс-инерционных
характеристик. Типы материала могут различаться для каждой детали, приводя к точным
масс-инерционным характеристикам вне зависимости от характеристик всей сборки.

Для расчета масс-инерционных характеристик
1. Выполните расчет масс-инерционных характеристик.

Контекстное Меню В графической области, щелкните правой кнопкой мыши по и
выберите Analysis → Mass Properties.

Пиктограмма Mass Properties

Меню Desktop Assembly → Analysis → Mass Properties

Команда AMASSMPROP

2. Ответьте на запросы следующим образом:
Enter an option (parts/subassemblies) [Name/Select] <Select>: нажмите ENTER

Select part and Subassembly instances: Выберите PLIERB

Select part and Subassembly instances: нажмите ENTER

3. В диалоговом окне Assembly Mass Properties (Масс-Инерционные Свойства
Сборки)укажите:
% Error: ENTER 2.0

Coordinate System: UCS

Assembly units: In

Mass units: Lbs

Выберите материал.

4. В диалоговом окне Select Material (Выбор Материала), выберите Mild_Steel
(Низкоуглеродистая Сталь).
Part/Subassembly Definition: PLIERB
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5. Выберите Assign (Назначить). Затем нажмите ОК.

6. Нажмите ОК, чтобы закрыть диалоговое окно Assembly Mass Properties (Масс-
Инерционные Свойства Сборки).

Появится диалоговое окно Assembly Mass Property Results (Результаты Расчета Масс-
Инерционных Свойств Сборки).

Выберите Done.

Масс-инерционные характеристики рассчитаны согласно установленным Вами
значениям.

ОБРАТИТЕ ВНИМАНИЕ Вы может сохранить расчеты свойств масс-инерционных
характеристик в файл, чтобы использовать их в анализе конструкции. В диалоговом окне
Assembly Mass Property Results (Результаты Расчета Масс-Инерционных Свойств
Сборки) выберите File.

Далее, Вы создадите сцены сборки.

Создание Сцен Сборки
Теперь, когда все детали были введены и на сборку были наложены зависимости, Вы
можете создавать и располагать сцены сборки. Сцена - трехмерное представление
деталей, которая разделяет детали сборки или узла, чтобы показать, как они
соединяются вместе. Вы можете быстро создавать сцены; они обновляются
автоматически всякий раз при изменении сборки. Разделение деталей основано на
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коэффициенте расчленения, который Вы установите и от сборочных зависимостей,
используемых при позиционировании деталей. Вы можете создавать несколько
трехмерных представлений деталей одной и той же сборки и сохранять их для
дальнейшего использования.

Направляющие сборки указывают траекторию расчленения сборки. За исключением
основной детали, направляющие сборки могут быть созданы для всех деталей. Когда Вы
создаете направляющие сборки, для них автоматически создается новый слой.

Сначала, Вы устанавливаете коэффициент расчленения и, затем, создаете сцену
расчлененной сборки. Затем Вы добавляете направляющие, чтобы показать, как детали
собираются. Из сцены Вы создаете чертежные виды.

Для создания трехмерного представления деталей
1. Создайте новую сцену.

Обозреватель Выберите ярлычок Scene. Щелкните правой кнопкой мыши по
фону и выберите New Scene.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите New Scene.

Пиктограмма New Scene

Меню Desktop Assembly → Scene → New Scene

Команда AMNEW

2. Ответьте на запросы следующим образом:
Enter new Scene name of the Active assembly (S_PLIER) <SCENE1>:

Введите новое имя или нажмите ENTER

Если Вы используете Обозреватель, подсказка не отображается.

3. Установите коэффициент расчленения для сцены.

Обозреватель  Щелкните правой кнопкой мыши по Scene1 и выберите
коэффициент Explode.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Scene Explosion Factor.

Меню Desktop Assembly → Exploded Views → Scene Explosion Factor

Команда AMXFACTOR

4. Ответьте на запросы следующим образом:
Enter Scene name to change or [?] <SCENE1>: нажмите ENTER

Enter new explosion factor for "SCENE1" or [Reset] <0.0000>: Введите 1.5
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Если Вы используете Обозреватель, чтобы установить коэффициент расчленения,
запросы не отображаются. Введите 1.5 в диалоговом окне Explode Factor (Коэффициент
расчленения) и нажмите ОК.

Будет показана расчлененная сцена сборки. Ее имя отображается под командной
строкой. Обозреватель показывает все детали в сцене.

Затем, выровняйте расчлененные в сборочной сцене детали. Вы можете точно настроить
позицию и ориентацию отдельных деталей или вращать их для лучшей видимости.

Для совмещения деталей в сцене
1. Точно настройте положение детали HEXNUT, переместив ее ближе к другим деталям.

В Обозревателе выберите ярлычок Scene. Если сцена не активизирована, Вы не
сможете точно настроить положение деталей для корректировки их положения или
добавления направляющих, показывающих направление сборки.

Обозреватель  Щелкните правой кнопкой мыши по HEXNUT_1 и выберите New
Tweak.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите New Tweak.

Пиктограмма New Tweak

Меню Desktop Assembly → Exploded Views → New Tweak

Команда AMTWEAK

1. Ответьте на подсказку следующим образом:
Select part or Subassembly to Tweak: Выберите HEXNUT (1)

В диалоговом окне Tweak Part/Subassembly, выберите Move.

Нажмите ОК для продолжения в командной строке.
Select Reference geometry: Выберите круглую кромку или внешнюю поверхность HEXNUT
(2)

Enter Distance <0.0000>: Введите .5
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HEXNUT установлена точно на указанное расстояние.

ОБРАТИТЕ ВНИМАНИЕ Положение основной детали сборки или узла не может быть
изменено. Их позиция фиксирована.

4. Используйте направляющие сборки, чтобы показать направление расчленения и
траектории точной подстройки.

Обозреватель  Щелкните правой кнопкой мыши по HEXBOLT_1 и выберите New
Trail.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите New Trail.

Пиктограмма New Trail

Меню Desktop Assembly → Exploded Views → New Trail

Команда AMTRAIL

5. Ответьте на подсказку следующим образом:
Select Reference point on part or Subassembly: Выберите конец HEXBOLT (1)

6. В диалоговом окне Trail Offsets (Отступы Направляющей) укажите:
Offset at Current Position: Distance: Введите 1

Over Shoot: Включите переключатель

Offset at Assembled Position: Distance: Введите 1

Over Shoot: Включите переключатель
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Нажмите ОК.

Отображается направляющая сборки для HEXBOLT.

7. Создайте направляющие сборки для деталей PLIERB и HEXNUT.

Обозреватель  Щелкните правой кнопкой мыши по HEXBOLT_1 и выберите New
Trail.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите New Trail.

Пиктограмма New Trail

Меню Desktop Assembly → Exploded Views → New Trail

Команда AMTRAIL

8. Ответьте на подсказку следующим образом:
Select Reference point on part or Subassembly: Выберите внешнее отверстие
HEXNUT (2)

9. В диалоговом окне Trail Offsets (Отступы Направляющей) укажите:
Offset at Current Position: Distance: Введите 1

Over Shoot: Включите переключатель

Offset at Assembled Position: Distance: Введите 1

Over Shoot: Включите переключатель

Нажмите ОК.
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Сборочный чертеж автоматически обновляет текущую сцену и отображает
направляющие сборки.

Сохраните ваш файл. Нажмите ОК в диалоговом окне External Part Save (Сохранить
Внешнюю Ссылку) для сохранения текущих деталей.

Далее, Вы создадите чертежные виды сцены сборки.

Создание Чертежных Видов Сборки
После завершения модели сборки и сцены, Вы можете создавать двухмерные
ортогональные виды или трехмерные изометрические и трехмерные представления
деталей всей сборки. Затем Вы добавляете справочные размеры.

Вы можете создавать столько листов чертежей, сколько необходимо для полного
описания вашего проекта. Поскольку эта сборка маленькая, Вы создадите только один
лист чертежа.

Перед созданием базового вида сборки плоскогубцев, измените установку вывода на
печать и включите пользовательский размер бумаги. Затем установите лист чертежа для
упорядочивания чертежных видов.

Для добавления пользовательского листа бумаги
1. Переключитесь в режим Drawing.

Обозреватель Выберите ярлычок Drawing.

Пиктограмма Drawing Layout

Меню Desktop Drawing → Drawing Mode

Команда AMMODE

2. Добавьте пользовательский размер бумаги для существующего графопостроителя.

Обозреватель  Щелкните правой кнопкой мыши по Layout1 и выберите Plotter
Setup.

3. В диалоговом окне Page Setup (Установки Страницы) выберите ярлычок Plot Device
(печатающее Устройство) и укажите:
Name: DWF Classic.pc3
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4. Выберите Properties (Свойства).

5. В диалоговом окне Plotter Configuration Editor (Редактор Конфигурации
Графопостроителя) распахните User-Defined Paper Sizes and Calibration
(Пользовательские размеры Бумаги и Калибровка) . Выберите Custom paper size
(Пользовательский Размер Бумаги) и выберите Add (Добавить).

6. Используйте Custom Paper Size Wizard (Мастер Настройки Пользовательского Размера
Бумаги) и укажите размер бумаги 18 x 12 дюймов без отступов. Выбирайте Next пока
установка не будет закончена.

7. Сохраните ваши изменения в файле DWF Classic.pc3.
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Затем, Вы установите лист чертежа и вставите рамку.

Для установки листа чертежа
1. В диалоговом окне Page Setup (Установка Листа) выберите ярлычок Layout Settings и

укажите:
Paper Size: User 1 (18.00 x 12.00 inches)

Plot Scale: 1:1

Нажмите ОК.

2. Вставьте рамку.

Обозреватель Щелкните правой кнопкой мыши по Layout1 и выберите Insert Title
Block.

Команда MVSETUP

3. В текстовом окне AutoCAD ответьте на подсказку следующим образом:
Enter an option [Align/Create/Scale Viewports/Options/Title block/Undo]:

Введите t

Enter title block option [Delete Objects/Origin/Undo/Insert] <Insert>:

Нажмите ENTER

Enter number of title block to load or [Add/Delete/Redisplay]: Введите 8

ОБРАТИТЕ ВНИМАНИЕ Если Вы используете Обозреватель, первые два запроса не
появляются.

4. Продолжите в командной строке.
Create a Drawing Named ansi_b.dwg? <Y>: Введите n

Enter an option [Align/Create/Scale Viewports/Options/Title block/Undo]:

Нажмите ENTER

Рамка вставлена в рисунок.
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5. Выровняйте рамку по центру чертежа.

Пиктограмма Move

Меню Desktop Modify → Move

Команда Move

6. Ответьте на запросы следующим образом:
Select Objects: Выберите рамку

Select Objects: Нажмите ENTER

Specify base point or displacement: Укажите точку

Specify second point of displacement or <use first point as displacement>:

Укажите вторую точку

Затем, определите чертежные виды для отображения сборки.

Для создания базового вида сборки
7. Создайте базовый вид.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите New View.

Пиктограмма New View

Меню Desktop View → New View

Команда AMDWGVIEW

8. В диалоговом окне Create Drawing View (Создать Чертежный Вид) укажите:
Type: Base

Data Set: Scene: SCENE1
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Нажмите ОК.

9. Ответьте на запросы следующим образом:
Select a planar face, work plane, or [Ucs/View/worldXy/worldYz/worldZx]:

ENTER z

Select work axis or straight Edge [worldX/worldY/worldZ]: Введите x

Adjust orientation [Z-flip/Rotate] <accept>: Нажмите ENTER

Specify location of base View: Укажите точку

Specify location of base View: Укажите вторую точку иди нажмите ENTER

Отображается базовый вид.

Затем, создайте изометрический вид сборки.

Для создания изометрического вида сборки
1. Создайте изометрический вид сборки.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите New View.

Пиктограмма New View

Меню Desktop View → New View

Команда AMDWGVIEW
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2. В диалоговом окне Create Drawing View (Создать Чертежный Вид) укажите:
View Type: Iso

Data Set: Scene: SCENE1

3. В ярлычке Hidden Line (Скрытые Линии) укажите:
Calculate Hidden Lines: Выключите переключатель

Нажмите ОК.

4. Ответьте на запросы следующим образом:
Select parent View: Укажите базовый вид

Specify location for isometric View: Укажите точку размещения изометрического вида

Specify location for isometric View: Укажите другую точку или нажмите ENTER

Если Вы используете Обозреватель, Вас не запросят указать родительский вид.

Изучите Обозреватель. Виды вложены в пиктограмму Scene, которая входит в Layout1.

Сохраните ваш файл.

Теперь Вы можете добавлять справочные размеры, которые могут перемещаться,
замораживаться и размораживаться в каждом виде рисунка. Справочные размеры не
параметрические, но они обновляются при изменении модели.

Для добавления справочных размеров
1. Увеличьте область, которую Вы хотите образмерить.

Контекстное Меню В графической области щелкните правой кнопкой мыши и
выберите Zoom.

Пиктограмма Zoom

Меню Desktop View → Zoom → Realtime
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2. Добавьте справочный размер.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Reference Dimension.

Пиктограмма Reference Dimension.

Меню Desktop Annotate →  Reference Dimension.

Команда AMREFDIM

3. Ответьте на запросы следующим образом:
Select first object: Укажите конечную точку губок (1)

Select second object or place Dimension: Укажите болт (2)

Specify Dimension Placement: Укажите точку над губками (3)

Specify placement point or [Undo/Hor/Ver/Align/Par/aNgle/Ord/reF/Basic]:

нажмите ENTER

Select first object: нажмите ENTER

К текущему виду добавился справочный размер.

Сохраните ваш файл.

Теперь, когда Вы создали чертежные виды, Вы отредактируете деталь и автоматически
обновите чертежные виды.

Редактирование Сборок
Изменения конструкции или спецификации требуют частого редактирования для
большинства сборок. Вы изменяете детали, переставляете детали и элементы в
иерархии дерева сборки и изменяете или удаляете зависимости. Поскольку детали и
сборка параметрические, изменения проходят быстро, а обновления - немедленно.

Редактирование определения внешней детали автоматически изменяет сборочную
модель везде, где она является вхождением.
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Редактирование Внешних Деталей

Для обновления всех вхождений детали в сборках, Вы должны отредактировать
исходную деталь. Вы изменяете ее элементы, изменяя размеры, зависимости или
добавляя новые элементы. Изменения вступают в силу в сборке.

В настоящем учебном пособии, Вы отредактируете внешнюю деталь PLIERT из вашего
сборочного чертежа. Это называется, редактированием на месте. На следующих
этапах, Вы добавите другое отверстие к детали PLIERT и измените сборочные
зависимости.

Для редактирования внешней детали на месте
1. Возвратитесь в режим Model.

Обозреватель Выберите ярлычок Model.

Пиктограмма Part Modeling

Команда AMMODE

2. Активизируйте деталь PLIERT.

Обозреватель  Щелкните правой кнопкой мыши по PLIERT_1 и выберите Activate
Part.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Part → Activate Part.

Пиктограмма Activate Part

Меню Desktop Part → Part → Activate Part

Команда AMACTIVATE

Неактивные детали станут серыми в Обозревателе и потускнеют на экране.

Тусклые неактивные детали, упростят для Вас работу с активной внешней деталью без
перемещения других деталей.

3. Обратите внимание на красный замок перед пиктограммой PLIERT в Обозревателе. Это
указывает, что файл заблокирован и не может изменяться другим пользователем.

ОБРАТИТЕ ВНИМАНИЕ Для ясности, видимость других деталей была выключена в этом
разделе. По желанию, можете выключить видимость PLIERB, HEXBOLT и HEXNUT до
активизации PLIERT.
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4. Увеличьте изображение PLIERT.

5. Создайте новую плоскость эскиза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите New Sketch Plane.

Пиктограмма New Sketch Plane

Menu Desktop Part → New Sketch Plane

Команда AMSKPLN

6. Ответьте на запросы следующим образом:
Select work plane, planar face or [worldXy/worldYz/worldZx/Ucs]:

Убедитесь, что передняя поверхность детали подсвечена, и нажмите ENTER (1)

Plane = Parametric

Select Edge to align X axis or [Z-flip/Rotate] <accept>:

Укажите, чтобы ось Z  указывала вниз от корпуса камеры

Enter an option [Accept/Next] <Accept>:

Убедитесь, что ось Х вертикальна, а ось Z указывает от детали и нажмите ENTER

Плоскость эскиза определена на передней поверхности плоскогубцев. Теперь, создайте
новое глухое отверстие, чтобы увеличить ход плоскогубцев.

Для создания нового элемента на внешней детали
1. Используйте команду Circle для создания нового отверстия.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Circle.

Пиктограмма Circle

Меню Desktop Design → Circle → Center, Radius

Команда CIRCLE
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2. Ответьте на запросы  следующим образом:
CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:

Укажите точку на выходе из отверстия

Specify radius of circle or [Diameter]:

Нарисуйте круг, приблизительно того же радиуса, что и отверстие

3. Преобразуйте эскиз в профиль.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Profile.

Пиктограмма Profile

Меню Desktop Design → - Sketch Solving → Profile

Команда AMPROFILE

Mechanical Desktop укажет, что для полного определения эскиз потребуется три размера.
Наложите зависимости на круг, добавляя параметрические размеры и создайте элемент.

Увеличьте масштаб отображения отверстия, при необходимости.

4. Добавьте размеры для определения профиля.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

5. Ответьте на запросы следующим образом:
Select first object: Выберите круг (1)

Select second object or place Dimension:

Укажите точку для размещения размера (2)

Enter Dimension value or [Undo/Radius/Ordinate/Placement point]

<0.2003>: Введите .22

Solved underconstrained sketch requiring 2 Dimensions or Constraints.

Select first object: Выберите круг (1)

Select second object or place Dimension: Выберите существующее выдавленное отверстие (3)

Specify Dimension Placement: Укажите точку для размещения размера (4)

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<0.0454>: Введите 0

Solved underconstrained sketch requiring 1 Dimensions or Constraints.
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Select first object: Выберите круг (1)

Select second object or place Dimension: Выберите верхнюю линию PLIERT (5)

Specify Dimension Placement: Укажите точку для размещения размера (6)

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<0.5093>: Введите .45

Solved fully constrained sketch.

Select first object: нажмите ENTERя
Круг теперь ограничен.

6. Выдавите новое отверстие через плоскогубцы.

Обозреватель  Щелкните правой кнопкой мыши по Profile5 и выберите Extrude.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Extrude.

Пиктограмма Extrude

Меню Desktop Part → Sketched Features → Extrude

Команда AMEXTRUDE

7. В диалоговом окне Extrusion (Выдавливание) укажите:
Termination: Through

Operation: Cut

8. Нажмите ОК для выхода из диалогового окна.

Новое отверстие выдавлено и его положение привязано к исходному отверстию.

Сохраните ваш файл.

Диалоговое окно External Part Save (Сохранение Внешней Детали) показывает изменение
в рисунке PLIERT.
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9. Нажмите ОК, чтобы сохранить проведенные изменения.

Обозреватель возвращается в исходное состояние. Неактивные детали становятся
доступными и в сборке показывается новая деталь PLIERT.

Редактирование Сборочных Зависимостей

Используя Обозреватель, Вы можете выборочно удалять, редактировать и добавлять
зависимости для перестраивания или изменения зависимостей деталей.

Используйте команду MOVE для перемещения деталей при редактировании и
добавлении зависимостей. Если Вы не хотите, чтобы детали повторно группировались в
процессе редактирования, установите системную переменную AMAUTOASSEMBLE в 0
(выкл). Для повторного группирования деталей после добавления зависимостей,
выберите пиктограмму Update в Обозревателе.

Для удаления сборочных зависимостей
1. В Обозревателе, щелкните по знаку "плюс" на PLIERB_1, чтобы развернуть структуру.

Выберите фильтр Сборки внизу Обозревателя, чтобы отфильтровать всю информацию
кроме зависимостей сборки.
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2. В Обозревателе, щелкните по знаку "плюс" на HEXBOLT_1, чтобы развернуть структуру.
Щелкните правой кнопкой мыши по зависимости Mate ln/ln в HEXBOLT_1 и выберите
Delete.

3. Удалите зависимости Mate ln/ln в HEXBOLT_1.

4. Удалите зависимости для PLIERB, PLIERT и HEXNUT.

5. Используйте MOVE для разделения деталей и наложения новых зависимостей.

Пиктограмма Move

Меню Desktop Modify → Move

Команда Move

Затем, Вы наложите новые сборочные зависимости. Вы используете зависимость
вставки для совмещения HEXBOET с новым отверстием по их осям с одновременным
совмещением поверхности PEIERT и соответствующей поверхности головки болта.

Используйте DOF символ, чтобы узнать скольких степеней свободы лишена каждая
деталь.

Для наложения сборочных зависимостей
1. Наложите зависимости на PLIERT_1 и HEXBOLT_1.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 3D Constraints  → Insert.

Пиктограмма Insert

Меню Desktop Assembly → 3D Constraints  → Insert

Команда AMINSERT

2. Ответьте на запросы следующим образом:
Select first circular Edge: Выберите новое отверстие под болт PLIERT (1)

First Set = Plane/Axis

Enter an option [Clear/Flip] <accept>:

Измените направление внутрь HEXBOLT и нажмите ENTER
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Select second circular Edge: Выберите тело болта возле головки (2)

Second Set = Plane/Axis

Enter an option [Clear/Flip] <accept>:

Измените направление внутрь PLIERT и нажмите ENTER

Enter offset <0.0000>: нажмите ENTER

Болт теперь проходит через новое отверстие.

3. Используйте зависимость вставки для связывания PLIERB и PLIERT, выравнивания
деталей по осям нового отверстия и соответствующего отверстия в PLIERB.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 3D Constraints  → Insert.

Пиктограмма Insert

Меню Desktop Assembly → 3D Constraints  → Insert

Команда AMINSERT

4. Ответьте на запросы следующим образом:
Select first circular Edge: Выберите новое отверстие под болт PLIERT (3)

First Set = Plane/Axis

Enter an option [Clear/Flip] <accept>:

Измените направление внутрь PLIERB и нажмите ENTER

Select second circular Edge: Выберите отверстие на внутренней поверхности PLIERB (4)

Second Set = Plane/Axis

Enter an option [Clear/Flip] <accept>:

Измените направление внутрь PLIERB и нажмите ENTER
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ENTER offset <0.0000>: нажмите ENTER

Детали PLIERB и PLIERT связаны друг к другом по внутренней поверхности и по осям
нижнего из отверстий PLIERT и единственного отверстия PLIERB. Степени свободы
определены. В этом случае, Вы позволили плоскогубцам и болту поворачиваться по оси,
так как степень подвижности вращения осталось неограниченной.

5. Используйте Вставку для наложения зависимостей на торцевые плоскости HEXNUT и
PLIERB в болтовых отверстиях. Переместите детали так, чтобы Вы видели выбираемые
точки.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 3D Constraints  → Insert.

Пиктограмма Insert

Меню Desktop Assembly → 3D Constraints  → Insert

Команда AMINSERT

6. Ответьте на запросы следующим образом:
Select first circular Edge: Выберите отверстие под болт PLIERT (5)

First Set = Plane/Axis

Enter an option [Clear/Flip] <accept>:

Измените направление внутрь HEXNUT и нажмите ENTER

Select second circular Edge: Выберите отверстие на HEXNUT(6)

Second Set = Plane/Axis

Enter an option [Clear/Flip] <accept>:

Измените направление внутрь PLIERB и нажмите ENTER

ENTER offset <0.0000>: нажмите ENTER



Mechanical Desktop Tutorials Release 4

Глава 12  Сборка Деталей 381

Детали PLIERB и PLIERT связаны по их торцевым плоскостям. Болт проходит через обе
детали, а отверстия и тело болта выровнены по их осям.

7. Убедитесь, что детали собраны правильно.

Пиктограмма Top View

Меню Desktop View → 3D Views → Top

8. Вернитесь к изометрическому виду.

Пиктограмма Правое Переднее Изометрический вид

Пиктограмма Right Front Isometric View

Меню Desktop View → 3D Views → Front Right Isometric
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